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SIMIT PROCESS SIMULATION – Coupling 
with S7-PLCSIM Advanced via OPC UA 

1 Goal 

The following pages will show how a coupling with SIMATIC S7-PLCSIM Advanced via OPC UA can be 

set up in the SIMIT process simulation software. 

The order in which existing SIMIT projects with this coupling variant can be started together with a TIA 

Portal project for simulation of a program solution will also be described. 

 

2 Requirement 

This chapter builds on the chapter "SCE_EN_092-300 OPC UA with SIMATIC S7-1500 as OPC Server 

…". To perform the work in this chapter, you can use the following project, for example: "sce-092-300-

opc-ua-s7-1500….". 
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3 Required hardware and software 

1 Engineering station: Requirements include hardware and Windows 10 operating system 

(for additional information, see Readme on the TIA Portal Installation DVDs) 

2 SIMATIC STEP 7 Professional software in TIA Portal – V15.1 or higher 

3 SIMATIC S7-PLCSIM Advanced software – V2.0 SP1 or higher 

4 SIMIT software – V10.0 Update 1 or higher (with dongle or in Demo mode) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 Engineering station 

 

2 SIMATIC STEP 7 
Professional (TIA 
Portal) – V15.1 or 

higher 

 

4 SIMIT – V10.0 
Update 1 or higher 

 

3 SIMATIC S7-PLCSIM 
Advanced – V2.0 SP1 

or higher 
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4 Theory 

4.1 SIMIT V10 

SIMIT is process simulation software that can be used for the following: 

– Complete plant simulation 

– Simulation of signals, devices and plant responses 

– Input and output simulator of test signals for an automation controller 

– Testing and commissioning of automation software 

 

SIMIT provides the following components for creating a simulation: 

Chart 

To build a simulation, components available in the libraries are put together in the chart editor and 

suitable parameters are entered. 

Visualization 

Visualizations provide an overview of the signals of your plant. Signals are visualized with controls 

(input and display objects) and graphical objects. 

Coupling 

The coupling is the interface to the automation system and is required for signal exchange. In addition 

to couplings with PLCSIM, PLCSIM Advanced, PRODAVE, etc., there is also a coupling with SIMIT 

as OPC UA client. 

 

Demo mode 

In demo mode you can get an impression of the use and performance capability of SIMIT without having 

to have a valid license.  

However, SIMIT has only a limited range of functions in demo mode. 

Existing models can be opened and simulated in demo mode. It is also possible to change these models 

and create new models. The models created or modified in this way can only be run on the computer on 

which they were created. 

SIMIT Simulation is limited to 45 minutes in demo mode. The simulation must then be restarted. 

 

 Note:  

 –   Further details and information can be found in the manuals, which can be downloaded from  

      support.automation.siemens.com. 

http://support.automation.siemens.com/
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5 Required settings in Windows 10 

Before you can set up a coupling with SIMATIC S7-PLCSIM Advanced via OPC-UA in the SIMIT process 

simulation software, the following settings in Windows 10 must be checked. 

5.1 Read permission for the SIMIT directory 

The user who is logged onto the computer must have read permission for the following drive path:   

 

C:\ProgramData\Siemens\Automation\SIMIT\8.0\PKI\own\private 

 

→ Navigate with Windows 10 Explorer to the specified directory C:\ProgramData\Siemens\ 

Automation\SIMIT\8.0\PKI\own\private (→ Explorer → C → ProgramData → Siemens→ Automation 

→ SIMIT→ 8.0→ PKI→ own→ private) 
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→ If you receive the message shown here, you can get access to this folder by clicking "Continue". 

However, this only works if you have administrator rights on the computer. If not, you must reach out 

to your administrator. (→ Continue) 

 

 

5.2 Set IP address of Siemens PLCSIM Virtual Ethernet Adapter 

For SIMATIC S7-PLCSIM Advanced to be accessed from the TIA Portal via TCP/IP, the IP address of 

the Siemens PLCSIM Virtual Ethernet Adapter must be set to match the IP address of the CPU in the TIA 

Portal project. 

The procedure for setting the IP address of the Siemens PLCSIM Virtual Ethernet Adapter with Windows 

10 operating system is shown here. 

→ Select the network icon in the taskbar at the bottom  and click → "Network settings". 
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→ In the network settings window that opens, click → "Ethernet" and then on → "Change adapter 

options". 
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→ Select → "Siemens PLCSIM Virtual Ethernet Adapter" and click → "Properties". 

 

 

→ Select → "Properties" for → "Internet Protocol Version 4 (TCP/IPv4)". 
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→ You can now use the following IP address, for example → IP address: 192.168.0.99 and enter the 

following → subnet mask 255.255.255.0. Then apply the settings. (→ "OK") 
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6 Task 

A SIMIT simulation with a coupling with SIMATIC S7-PLCSIM Advanced via OPC UA is to be created. In 

so doing, the symbols of the inputs and outputs in SIMATIC S7-PLCSIM Advanced are to be accessed. 

7 Planning 

First, an existing TIA Portal project with activated OPC UA server is retrieved. 

The following changes will then be made there: 

– In the project properties, the "Support simulation during block compilation" option must be selected 

for "Protection". 

– All FBs and DBs are removed from the project because the tags created there will otherwise be 

imported as signals. 

– In the tag tables, the "Writable from HMI/OPC UA" attribute must be deselected for the PLC outputs. 

Otherwise, they will be imported into SIMIT as PLC inputs. 

– The IO addresses to be simulated using SIMIT must not exist as hardware modules. Accordingly, we 

remove all affected IO modules. 

Finally, the hardware configuration with the tag tables is also downloaded to SIMATIC S7-PLCSIM 

Advanced.  

Now, a SIMIT project is created and a new "OPC UA Client" coupling with SIMATIC S7-PLCSIM 

Advanced is created there. 

Next, the IO addresses are imported from SIMATIC S7-PLCSIM Advanced via OPC UA. 

 

For simulation of a program solution, an existing TIA Portal project with activated OPC UA server is 

opened and downloaded to SIMATIC S7-PLCSIM Advanced. 

The SIMIT project is then opened and started for testing the program solution. 
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8 Structured step-by-step instructions 

You can find instructions on how to implement planning below. If you have advanced knowledge, the 

numbered steps are sufficient. Otherwise, it is recommended that you follow the individual steps of the 

instructions. 

8.1 Retrieve an existing project in the TIA Portal 

→ Before you can access the "sce-092-300-opc-ua-s7-1500…" project from chapter "SCE_EN_092-

300-OPC UA-S7-1500", you must retrieve it. To retrieve an existing project that has been archived, 

you must select the relevant archive with → Project → Retrieve in the project view. Confirm your 

selection with "Open". (→ Project → Retrieve → Select a .zap archive … → Open) 

 

 

→ The next step is to select the destination folder where the retrieved project will be stored. Confirm 

your selection with "OK" (→ Destination folder … → OK). 
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→ In the project properties, the "  Support simulation during block compilation" option still needs to be 

selected for "Protection". (→ 092-300_OPC UA S7-1500… → Properties → Protection →  Support 

simulation during block compilation → OK) 
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→ All FBs and DBs are to be removed from the project because the tags created there will otherwise be 

imported as signals. Here, we delete all program blocks of the project by selecting them and right-

clicking. We now select "Delete" from the options. (→ CPU_1516F → Program blocks → Delete) 
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→ In the tag tables, the "Writable from HMI/OPC UA" attribute must be deselected for the PLC outputs. 

Otherwise, they will be imported into SIMIT as PLC inputs. Open the "Tag table_sorting station" and 

deselect the "Writable from HMI/OPC UA" attribute for all output signals. (→ CPU_1516F → PLC 

tags → Tag table_ sorting station → Writable from HMI/OPC UA) 
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→ The IO addresses to be simulated using SIMIT must not exist as hardware modules. Accordingly, we 

also remove all IO modules by selecting them, right-clicking on them and selecting "Delete". (→ 

CPU_1516F → Device configuration → Delete) 

 

→ Then click on the "CPU_1516F" folder. In the menu, first select the " " button and then 

the " " button for compiling. (→ CPU_1516F →  → ) 
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8.2 Download the TIA Portal project to SIMATIC S7-PLCSIM Advanced 

Before you can download the CPU_1516F from the project "092-300_OPC UA S7-1500", SIMATIC S7-

PLCSIM Advanced must be opened and a CPU with the appropriate settings must be started there. 

→ Open "S7-PLCSIM Advanced" from the desktop of your computer by double-clicking on the logo for 

the application. (→ S7-PLCSIM Advanced) 

 

 

→ In the "Control Panel" of S7-PLCSIM Advanced, select the settings shown here for the virtual S7-

1500 and start it. (→ Control Panel → PLCSIM Virtual Ethernet Adapter → <Local> → CPU_1516F 

→ 192.168.0.1 → 255.255.255.0 → Unspecified CPU 1500 → Start) 
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→ The virtual S7-1500 is now started in S7-PLCSIM Advanced.  The virtual controller of the TIA Portal 

and SIMIT can be accessed via the configured address.  
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→ To download your entire CPU, select the → "CPU_1516F [CPU1516F-3 PN/DP]" folder in the TIA 

Portal and click the "Download to device" button  → .  

 

→ The manager for configuring connection properties then opens. (Extended download). 
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→ First, the interface must be correctly selected. This happens in three steps. 

→ Type of the PG/PC interface → PN/IE 

 

→ PG/PC interface → here: Siemens PLCSIM Virtual Ethernet Adapter 

 

→ Connection to interface/subnet → "PN/IE_1" 
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→ The → "Show all compatible devices" check box must then be selected. The search for devices in 

the network is started by clicking the →  button. 
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→ If the controller is shown in the list, it must be selected before the download can be started.  

(→ CPU1516F-3 PN/DP → Load) 
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→ You first obtain a preview. Confirm the suggested actions and continue with → "Load". 

 

Note:  

– The  symbol should be visible in every line of the "Load preview". You can find additional 

information in the "Message" column 

→ The → "Start module" option is now selected before the download operation can be completed with 

→ "Finish". 
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8.3 Create a SIMIT application with "OPC UA Client" coupling  

→ Start SIMIT from the desktop of your computer by double-clicking on the logo for the "SIMIT SP" 

application (→ SIMIT SP) 

 

 

→ Create a new project "020-111_SIMIT PLCSIMAdv OPC UA". (→ Create new project → 020-

111_SIMIT PLCSIMAdv OPC UA → Create) 
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→ Change to the "Project view". (→ Project view) 
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→ Create a "New coupling" "OPC UA Client" for your project under "Couplings".  

(→ Couplings → New coupling → OPC UA Client → OK) 
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→ Switch to the TIA Portal and open the "Device configuration" in the previously retrieved project "092-

300_OPC UA S7-1500". Select the CPU. In the properties under OPC UA, copy the address of the 

activated OPC UA server. (→ 092-300_OPC UA S7-1500 → Device configuration → CPU_1516F → 

Properties → OPC UA → General → Server addresses → opc-tcp://192.168.0.1:4840 → Copy) 
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→ Paste the previously copied OPC UA server address of the CPU 1516F into SIMIT as "OPC UA 

Server URL" under "Couplings", "OPC UA client". (→ SIMIT → Couplings → OPC UA Client → 

Properties → OPC UA Server URL → Paste) 
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→ Under "Properties", select the settings shown below for "Endpoint" and "Namespace URI". (→ 

Properties → Endpoint → Name space URI) 

 

 

Note:  

– If the following error message appears, you need to check the requirements of the settings in  

Windows 10 described in chapter 5. 
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→ When you click the " " button, the inputs and outputs from the tag table previously downloaded 

to the CPU 1516F are imported and are now ready for further use in the simulation. (→ Browse) 

 

→ Finally, select "  Save all". (→ ) Click "  Start" to start the simulation. (→ ) 
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→ After starting the simulation, you can test the access to the inputs and outputs of SIMATIC S7-

PLCSIM Advanced in SIMIT.  

→ You can see whether this access is functioning in the tag tables in TIA Portal by clicking the " " 

symbol. (→ ) 

→ Clicking on " " again ends the simulation in SIMIT. (→ ) 
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→ Now "Archive" the SIMIT project. (→ Project → Archive) 
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8.4 Start an existing SIMIT project with "OPC UA Client" coupling with 

SIMATIC S7-PLCSIM Advanced as OPC UA server 

→ First, start the TIA Portal from the desktop of your computer by double-clicking on the logo for the 

application. (→ TIA Portal) 

 

 

→ Open or retrieve the desired TIA Portal project. Here, the project for the sorting station "sce-092-300-

opc-ua-s7-1500…" is opened. Switch to the Project view. (→ Open existing project → sce-092-300-

opc-ua-s7-1500… → Open → Project view) 
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Before you can download the CPU_1516F from the "092-300_OPC UA S7-1500" project, SIMATIC S7-

PLCSIM Advanced must be opened and a CPU with the appropriate settings must be started. 

→ Open "S7-PLCSIM Advanced" from the desktop of your computer by double-clicking on the logo for 

the application. (→ S7-PLCSIM Advanced) 

 

 

→ In the "Control Panel" of S7-PLCSIM Advanced, select the settings shown here for the virtual S7-

1500 and start it. (→ Control Panel → PLCSIM Virtual Eth. Adapter → <Local> → CPU_1516F → 

192.168.0.1 → 255.255.255.0 → Unspecified CPU 1500 → Start) 
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→ The virtual S7-1500 is immediately started in S7-PLCSIM Advanced and can be accessed from the 

TIA Portal and SIMIT via the configured address.  
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→ To download your entire CPU, select the → "CPU_1516F [CPU1516F-3 PN/DP]" folder and click the 

 → "Download to device" button.  

 

Note:  

– The IO addresses to be simulated using SIMIT must not exist as hardware modules. 
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→ The manager for configuring the connection properties (Extended download) then opens. 
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→ First, the interface must be correctly selected. This happens in three steps. 

→ Type of the PG/PC interface → PN/IE 

 

→ PG/PC interface → here: Siemens PLCSIM Virtual Ethernet Adapter 

 

→ Connection to interface/subnet → "PN/IE_1" 
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→ The → "Show all compatible devices" check box must then be selected. The search for devices in 

the network is started by clicking the →  button. 
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→ If the controller is shown in the list, it must be selected before the download process can be started. 

(→ CPU1516F-3 PN/DP → Load) 
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→ You first obtain a preview. Confirm the suggested actions and continue with → "Load". 

 

Note:  

– The  symbol should be visible in every line of the "Load preview". You can find additional 

information in the "Message" column. 

→ Following this, the → "Start module" option is selected before the download operation can be 

completed with → "Finish". 
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→ Now start SIMIT from the desktop of your computer by double-clicking on the logo for the "SIMIT SP" 

application (→ SIMIT SP)   

 

 

→ Open or retrieve the desired project. Here, the project for the sorting station "sce-020-111-sce-

sorting-station-plcsim-advanced-opc-ua-r1904-en.simarc" is retrieved from the archive. (→ Retrieve 

project → sce-020-111-sce-sorting-station-plcsim-advanced-opc-ua-r1904-en.simarc → Retrieve) 
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→ Confirm the security prompt with "Yes". (→ Yes) 

 

 

→ Change to the "Project view". (→ Project view) 
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→ Double-click the "01_operating screen" chart to open it. (→ 01_operating screen) 

 

 

→ Select "  Save all" and select "  Start" to start the simulation. (→  → ) 
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→ The simulation is activated. The application turns orange to indicate this. 

 

 

→ The application can be subsequently be tested in SIMIT. Clicking on " " again ends the simulation 

in SIMIT. (→ ) 
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9 Additional information 

 

More information for further practice and consolidation is available as orientation, for example: 

Getting Started, videos, tutorials, apps, manuals, programming guidelines and trial software / 

firmware, under the following link: 

 

 

siemens.com/sce/s7-1200 

 

Preview „Additional information“  

 

 

 

 

 

 

 

http://www.siemens.com/sce/s7-1200
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Further Information 
 

Siemens Automation Cooperates with Education 
siemens.com/sce 

SCE Learn-/Training Documents 

siemens.com/sce/documents 

SCE Trainer Packages 

siemens.com/sce/tp 

SCE Contact Partners  

siemens.com/sce/contact 

Digital Enterprise 

siemens.com/digital-enterprise 

Industrie 4.0  

siemens.com/future-of-manufacturing 

Totally Integrated Automation (TIA) 

siemens.com/tia 

TIA Portal 

siemens.com/tia-portal 

SIMATIC Controller 

siemens.com/controller 

SIMATIC Technical Documentation  

siemens.com/simatic-docu 

Industry Online Support 

support.industry.siemens.com 

Product catalogue and online ordering system Industry Mall  

mall.industry.siemens.com 
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